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 Welcome to the world of TK-78K0/KF2+UZ. 
  
You are now being navigated to the design environment 
of the 78K0 microcontroller for developing wireless 
network applications. Please follow the tutorial step by 
step. 
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[NOTES] 
The information in this document is subject to change without notice. No part of 
this document may be copied or reproduced in any form or by any means without 
the prior written consent of TESSERA TECHNOLOGY INC.. 
TESSERA TECHNOLOGY INC.. assumes no liability for infringement of patents 
or copyrights of third parties by or arising from use of a product described herein. 
This product is designed and manufactured with intention for use in evaluation 
and prototyping by engineers with knowledge of security, safety and reliability. 
TESSERA TECHNOLOGY INC.. would like to inform, that the standard quality 
assurance procedure(s) have not been fully applied to this product and its 
documentation and that TESSERA TECHNOLOGY INC.. cannot assure the full 
and error free function and/or the standard quality level. 
[CAUTION] 
This equipment should be handled like a CMOS semiconductor device. The user 
must take all precautions to avoid build-up of static electricity while working with 
this equipment. All test and measurement tool including the workbench must be 
grounded. The user/operator must be grounded using the wrist strap. The 
connectors and/or device pins should not be touched with bare hands. 
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1 Introduction 
 
 
 
Target Reader Software development engineers who wish to become 

familiar with the development environment of the 78K0 
microcontrollers. It is assumed that the readers have been 
familiar with basics of microcontrollers, C and assembler 
languages, and the WindowsTM operating system. 

 
Purpose For readers to become familiar with the design environment 

and the application examples of wireless networks. 
 
 
Overview This manual consists of the following contents 
 
Chapter 1 Preparations 
              →Introduction of soft tools, and sample programs and installation 
 
Chapter 2 Experiences 
              → Guide to the basic operations of PM plus and the integrated 

debugger using sample programs. 
 
Chapter 3 How To Use PG-FPL3 
              → How to program Flash EEPROM 
 
Chapter 4 IEEE 802.15.4 MAC Sample Programs                                           
              → Learn sample programs, which utilize the MAC library 
 
Chapter 5 Mode Setting of the Board 
  → Explanation of switch setting. 
 
 
Trademark Microsoft and Windows are either registered trademarks or 

trademarks of Microsoft Corporation in the United States and/or 
other countries. 
Adobe and Acrobat are trademarks of Adobe Systems 
Incorporated (Adobe System Incorporated). 
Other company names and product names that appear in this 
document are the registered trademarks or trademarks of their 
respective companies. 
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2 Preparations 
 

 
This chapter introduces the development environment and describes how to 
install the sample programs. The sample program can be tested on this 
hardware platform of the evaluation kit. 
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2.1 Development Tools, Sample Programs, and the MAC Library 
 
 
 

 
This section outlines the development tools, sample programs and the MAC 
library used in this tutorial.  

 

2.1.1 Integrated Development Environment PM plus V5.21 
This is a project manager, where you work for editing the source code, 
compiling it, and initiating the debugger. The project manager works on MS 
Windows 2000 or XP.  

 

2.1.2 Device file DF780547 V2.10  
A device file contains an MCU specific information. It instructs the 
development tools what kind of an MCU the tools shall work for.  

 

2.1.3 C Compiler CC78K0 W3.70: Code size limited version 
This is a free compiler for the 78K0 microcontrollers. The object code size 
is limited to 32 Kbytes. It works on MS Windows 2000 or XP. 

 

2.1.4 Assembler RA78K0 W3.80: Code size limited version 
This is a free assembler for the 78K0 microcontrollers. The object code 
size is limited to 32 Kbytes. It works on MS Windows 2000 or XP. The 
RA78K0 Assembler Package contains Structured Assembler Preprocessor, 
Assembler, Linker, Object Converter, Librarian, and List Converter. 
 

2.1.5 78K0 integrated debugger ID78K0-TK V2.02 
The Integrated Debugger ID78K0-TK offers a debug environment on your 
PC, where the MS Windows 2000 or XP runs, if the TK board is connected 
to the PC with USB. The USB I/F accesses to the OCD, On Chip Debug, 
interface on the microcontroller. ID78K0-TK is a software module added on 
ID78K0-QB.  

 

2.1.6 Portconfig for ID78K0-TK 
“Portconfig for ID78K0-TK" assigns the COM port number for the 
connection to the TK board. This is installed automatically, if the 
ID78K0-TK is installed in the PC.   

 

2.1.7 USB driver  
This is a software driver for PC to access to the USB interface of the 
TK-78K0/KF2+UZ board.  
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2.1.8 Flash EEPROM Programmer PG-FPL3 
PG-FPL3 is a software Flash EEPROM programmer, working on MS 
Windows. PG-FPL3 enables you to program your application program file 
of hex format in the Flash EEPROM, embedded on the 78K0/KF2 
microcontroller in the TK-78K0/KF2+UZ board, via the USB interface of the 
board.  
You do not need any hardware, additionally to your PC and the 
TK-78K0/KF2+UZ board, to make the programming.  

 

2.1.9 Parameter file 
A parameter file is required to inform PG-PFL3 of device specific 
parameters of Flash EEPROM. Please do not mix it up with a device file. 

 

2.1.10 The RF Test Program 
The RF Test Program is used in [chapter 3 Experiences]. 
 
The RF test program is provided in the form of the hex file, as well as the C 
source codes.  
 
The hex file, TK78K0KF2UZ_RF_TEST.hex, allows you to immediately 
program to your TK-78K0KF2+UZ boards using the PG-FPL3 Flash 
EEPROM programmer, and start RF testing. The 
TK78K0KF2UZ_RF_TEST.hex file is available at  
C:/Program Files/TK78K0KF2UZ_RF_Test_v2/Release. 
 
Or, if you wish to tailor the RF test program to meet your specific needs, 
you can edit the source code, re-compile it with debug build to generate a 
load module file, then, start the debugger to load the tailored execution 
code on to the microcontroller for further debugging on the project manager 
PM plus. In this procedure, the Flash programmer PG-FPL3 is not 
required. 
 
Alternatively, if debugging is not required, you can make a release build to 
achieve a new hex file, on the project manager PM plus. 
 

As a general remark, please respect your local regulation of 
electro-magnetic emission. In general, it is suggested to use the 
TK-78K0/KF2+UZ board in a radio anechoic chamber. 
 
 

2.1.11 IEEE 802.15.4 MAC Library 
The IEEE 802.15.4 MAC Library offers an executable object-code library of 
the MAC stack specified in the IEEE 802.15.4. Please refer to the MAC 
Library manual for further details. 
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2.1.12 The MAC Sample Program1 : Text Chat Program 
The MAC Sample program 1 is developed to provide with a simple 
example to construct a star network utilizing the IEEE 802.15.4 PHY/MAC 
standard. 
 
The MAC Sample Program 1 offers, 
1). Designation of a network coordinator in a star configuration 
2). Text chat between a coordinator and an end device 
 
To use the MAC Sample Program 1, you need to prepare at least two PC 
with a USB interface and two TK-78K0/KF2+UZ boards.  
The MAC Sample Program 1 is provided in the form of the hex file, as well 
as the C source codes.  
 
The hex files, TK78K0KF2UZ_Sample1_01.hex, _02.hex, _03.hex, 
_04.hex and _05.hex allow you to immediately program to your 
TK-78K0KF2+UZ boards using the PG-FPL3 Flash EEPROM programmer, 
and start the sample application. The TK78K0KF2UZ_Sample1_0x.hex 
files are available at  
C:/TK78K0/SAMPLE_KF2+UZ/TK78K0KF2UZ_Sample1/Release. 
 
Or, if you wish to tailor the sample program to meet your specific needs, 
you can edit the source code, re-compile it with debug build to generate a 
load module file, then, start the debugger to load the tailored execution 
code on to the microcontroller for further debugging on the project manager 
PM plus. In this procedure, the Flash programmer PG-FPL3 is not required. 
However, because the USB connection to instruct operation to the program 
is occupied for the debugging purpose, alternatively, you can make a 
release build to achieve a new hex file, on the project manager PM plus. 
 

As a general remark, please respect your local regulation of 
electro-magnetic emission. In general, it is suggested to use the 
TK-78K0/KF2+UZ board in a radio anechoic chamber. 
 
 
 

2.1.13 The MAC Sample Program2 : LED Control 
The MAC Sample program 2 is developed to provide with another simple 
example to construct a star network utilizing the IEEE 802.15.4 PHY/MAC 
standard. 
 
The MAC Sample Program 2 offers, 
1). Designation of a network coordinator in a star configuration 
2). LEDs on the coordinator board indicate which switch on which end 

device is pressed. 
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To use the MAC Sample Program 2, you need to prepare one PC with a 
USB interface and two TK-78K0/KF2+UZ boards or more boards, up to 5.  
The MAC Sample Program 2 is provided in the form of the hex file, as well 
as the C source codes.  
 
The hex file, TK78K0KF2UZ_Sample2.hex, allows you to immediately 
program to your TK-78K0KF2+UZ boards using the PG-FPL3 Flash 
EEPROM programmer, and start the sample application. The 
TK78K0KF2UZ_Sample2.hex file is available at  
C:/TK78K0/SAMPLE_KF2+UZ/TK78K0KF2UZ_Sample2/Release. 
 
Or, if you wish to tailor the sample program to meet your specific needs, 
you can edit the source code, re-compile it with debug build to generate a 
load module file, then, start the debugger to load the tailored execution 
code on to the microcontroller for further debugging on the project manager 
PM plus. In this procedure, the Flash programmer PG-FPL3 is not required. 
However, because the USB connection is occupied for the debugging 
interface, the USB connection is not available for applications. Alternatively, 
you may make a release build to achieve a new hex file, on the project 
manager PM plus. 
 

As a general remark, please respect your local regulation of 
electro-magnetic emission. In general, it is suggested to use the 
TK-78K0/KF2+UZ board in a radio anechoic chamber. 
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2.2 Installation of Software Development Tools 

 

 

2.2.1 Start-up of the installation CD-ROM 
 
The attached CD-ROM contains Development Tools, documents and sample 
soft ware.  
You can install it using an installer. 
(Expect for FPL3 and Parameter file.) 
 

2.2.2 Installation of the software development tools. 
 
Please insert the CD-ROM in the drive. The installer will show up automatically. 
If it does not start automatically, please initiate it by double clicking the 
SETUP.EXE. 

 

 
 

 
<1> Readme First 

The contents of the CD-ROM, and some notes are available. 
Please read it at first. 

<2> Install… 
Click “Install” to start installation of development tools. 
For details, please refer to the next section. 
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<3> Documents 
Manuals of development tools and the evaluation kit are available in PDF 
files. 
When this button is clicked, the WWW browser will start. Adobe® Acrobat® 
Reader is available in the CD-ROM. 

     
<4> Sample Program 

Click this button to start the WWW browser for the sample program and the 
tutorial. 

<5> Link to NEC Electronics Microcontrollers   
Click this button to start the WWW browser display the link to the NEC 
Electronics Microcontroller web site 
(http://www.necel.com/micro/index_e.html) 
The NEC Electronics Microcontroller web page provides with the latest 
product/tool information and FAQs.   

<6> Exit  
Terminate the setup. 
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<1> Select [Install] in the set-up menu with the welcoming robot. 

Check the box for “Tool Install”, check/clear the product to be installed in the 
boxes.  
“Explain” displays an explanation of the selected product. 
To change the installation destination, click [Browse…]. 
  
When all the settings are completed, click [Install…]. 
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<2> To install each development tool, click OK when the install confirmation
 screen is displayed.  To stop installation, click Cancel.  

 

 
 
 
<3> To install a product, click [Yes] when the software license agreement  

screen is displayed.  To stop installation, click [No].  
To return to the previous screen, click [< Back]. 
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<4>  Enter the product ID. The product ID is available on the CD-ROM  
package. 

 

 
 
 
<5>  Copying the files is started. 
 
 
<6>  When the files have been completely copied and if AUTOEXEC.BAT 

must be corrected, the following dialog box is displayed.  Select an  
option and click the [Next>] button. 
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<7>  If it is necessary to restart the computer, the following dialog box is  
displayed.   
Click [Yes] to restart the computer. 
 

 
 

<8>  If the computer does not have to be restarted, a dialog box indicating
 completion of setup is displayed.  Click the [OK] button.  This complet
es installation of each development tool. 

 

 
 

 
 Notes on the installation authority  
To install this tool in Windows 2000 or XP, the authority of a administrator is 
necessary. Therefore, please login as a administrator. 
 
 Notes on the install-directory  
Please do not use 2-byte characters, such as umlaut in the directory name, 
where the product is to be installed. 
 
 Note on the version of Windows  
If the language of the Windows is not English, a file transfer error during 
installation might be observed. In this case, please abort the installation in 
the language, and re-install it in an English version of Windows. 
 

The identical problem may be observed, if a language other than English is 
specified as the system language in the “Regional Settings Properties” tab. 
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2.2.3 Uninstall 
 
<1>  Start "Add /Remove Programs" in the Control Panel. 

(Example here is based on Windows2000) 
 

 
 
<2>  Select the tool that you want to uninstall from the list displayed in 

"Install/Uninstall" and click [Add/Remove...]. 
 
 
<3>  A dialog box for confirming deletion of files will be displayed.  Click    

Yes   .  Deleting of the files will be started. 
 

 
 

 
<4>  When the completion message is displayed, click    OK   . 

 
Caution: 
Deletion of some files may be asked during uninstallation.  Normally, 
deletion of these files causes no problem.  

 
<5>  This completes uninstalling this tool. 
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2.2.4 File Configuration in PC 
 

Software Development Tools are installed in "C:/NECTOOLS32" on default 
setting. 
When you use the tools, please open the tools from [Start menu] -> 
[Programs]->[NEC Tools32]. 
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2.3 Sample Environment 
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2.3.1 Installation of the sample programs 
Insert the CD-ROM disk in the CD-ROM drive of your PC. The [NEC Electronics 
Microprocessor Development Tools Setup] screen automatically appears.(if this 
screen does not appear automatically, start setup.exe from Explorer. etc.) 
Press the  Sample Program  button to start the WWW browser, and then click 
the [TK-78K0/KF2+UZ Sample Programs] link.  

   

 

 
 

When[TK-78K0/KF2+UZ Sample Programs] is clicked, the following 
download confimation window appears. 

The WWW 
browser starts 

up. 

Click the [TK-78K0/KF2+UZ 
Sample programs] link youcan 

also download the [Tutorial 
Guide] 
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Please click the Open button. 

In case of windows 2000, 
you will see the [Security Warning] window. Please click  Run . 

 

 
InstallShield wizard for TK-Sample Program starts up  

Please click  Next. 

 

 
License agreement screen is displayed. 
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Please select "I accept the terms in the license agreement".and click Next. 

 

 
Please click Finish. 

 
The sample programs are installded. 
 
Installed files  

● TK78K0 folder - - - - - - - - - - - sample programs 
● TK78K0.EXE - - - - - - - - - - - execute file  

  
When you uninstall the sample program. 
Please use "Add /Remove Programs" in the Control Panel. 

 

2.3.2 File Configuration of the sample program 
 
The sample programs ware the following folders. 

 
 
 
 
 
 
 
 
 
 
 

TK78K0 

SAMPLE_KF2+UZ 

 

TK78K0KF2UZ_RF_Test The sample program used in chapter 3. 

The packet error rate and received signal 

strength indication are monitored.  

TK78K0KF2UZ_Sample1 This sample program uses MAC library. 
The text message is transmitted and it receives it. 

TK78K0KF2UZ_Sample2 This sample program uses MAC library. 

Switch information is transmitted, it receives,  

and LED is blinked.. 
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2.4 USB Driver 
 
 
 
You need to install “USB Serial Converter” and “USB Serial Port” in your PC.  
 
When TK-78K0 is used, it is necessary to install “USB Serial Converter” and the 
“ USB Serial Port” driver in the host machine. Please install the driver according to 
the following procedures with appending CD in the drive. 
 

Attention  Please do not connect TK-78K0 by way of the USB 
hub. It is likely not to operate normally.  

 
 

2.4.1 Installation of the USB driver 
 

 
Install to Windows2000 
 

１．Once the TK-78K0/KF2+UZ board is inserted to the PC USB terminal, a wizard will be initiated by the MS 
Windows.  

 
 

New hardware wizard （Windows2000） 

 
 

 

Click 
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２．The following window is displayed,  please click “search for a suitable driver …..”  
 

Method 1（Windows2000） 

 
 
 

３．Please select the “CD-ROM drives” only. and click NEXT(N)>. 
 

driver file 1（Windows2000） 

 
 

 

Click 

“Search for a………” 
 Selection is confirmed. 

Click 

It is confirmed that "CD-ROM 
drives" is checked. 
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４．Please click  NEXT(N)> 
 

Instillation of the driver file 1 (Windows2000) 

 
 

 

 

５．The “USB Serial Converter" driver's installation is completed. Click  Finish . 
 

Completion of the USB Serial Converter driver installation 1 (Windows2000) 

 
 

 

Click 

Click 



- 28 - 

６．The “USB Serial Port" driver's installation begins continuously. Click NEXT(N)>. 
 

New hardware wizard 2（Windows2000） 

 
 

 

 

７．The following window is displayed. Select “Search for a suitable driver for my device”. and click 
NEXT(N)>. 

 

method 2（Windows2000） 

 
 

 

Click 

Click 

“Search for a …..” 
 selection is confirmed. 



- 29 - 

８．Please Select the “CD-ROM drives” only. And click NEXT(N)>. 
 

 

Driver file 2（Windows2000） 

 
 

 

 

９．Please Click NEXT(N)>. 
 Instillation of the driver file 2(Windows2000) 

 
 

Click 

It is confirmed that "CD-ROM 
drives" is checked. 

Click 
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１０． The“USB Serial Port”driver’s installation is completed. Click  Finish .  
 

Completion of the USB Serial Port driver installation (Windows2000) 

 
 
 
１１． Driver Install was finished. 
 

 

 

 

 

 

Click 
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Install to Windows XP 
 

１． Once the TK-78K0/KF2+UZ board is inserted to the PC USB terminal, a wizard will be initiated by the 
MS Windows.  

 
Installation1(WindowsXP) 

 
 
 
 
２． Select the “Install the software automatically …” has been selected, and click NEXT(N)>. 
 

New hardware wizard 1(WindowsXP) 

 
 

 

“Install the software…” Selection is 
confirmed. 

Click 

Click 

Select “No, not this time” 
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３． The “USB Serial Converter" driver's installation is completed. Click  Finish .  
 

Completion of the USB Serial Converter driver installation 1（WindowsXP） 

 
 

 

４． The “USB Serial Port" driver's installation begins continuously. Click NEXT(N)>. 
 

Installation2(WindowsXP) 

 
 
 

Click 

Click 

Select “No, not this time” 
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５． The “USB Serial Port" driver's installation begins continuously. Click NEXT(N)> 
 

New hardware wizard 2(WindowsXP) 

 
 

 

６． If the following window is displayed, the USB driver's installation is completed. Click  Finish. 
 

Completion of the USB Serial Port driver installation (WindowsXP) 

 
 

７． Driver Installation has been finished. 
 

Click 

Click 

“Install the software…” Selection is 
confirmed. 
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2.4.2 Confirmation of the installation  
 
Please confirm “USB Serial Port (COM?)” in the device manager of system in the 
control panel of the MS Windows. Then, please confirm “USB Serial Converter”. 
 
 

Device Manager 

 
 
 
※Attention 
 
Windows2000/XP 

Please do not do “Hardware Modification Scan” when you communicate 
with the target device. 

 

It is confirmed that “USB 
Serial Converter" exists. 

It is confirmed that “USB Serial 

Port (COM?)”exists. 
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2.4.3 Uninstallation of the USB driver  
 
The uninstall program, Ftdiunin.exe, is available at “/DRIVER/FTDI”. Please log 
on as an administrator, then, execute the Ftdiunin.exe  
  

The USB driver’s uninstall 

 
 
 
After TK-78K0 is detached, please click is Continue . 
 

Driver uninstaller 

 
 

Double click 

Click
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Please click Finish.  
 

The driver's uninstall completion 
 

 
 
 
 

Click
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3 Experiences 
 
 
Now you are ready to experience the operation of the TK-78K0/KF2+UZ using the 
integrated development environment, PM plus. 
 
Here, we use RF test program [TK78K0KF2UZ_RF_Test] as an example. 
 
This chapter is designed to provide with an understanding of how to work on PM 
plus, how to start-up the TK debugger, how to generate a hex file, and how to use 
the Flash programmer. 
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The overall flow is as follows. 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Starting integrated debugger (ID78K0-TK) 

Executing program 

Stopping program 

Operation 

Terminating integrated debugger (ID78K0-TK) 

Loading workspace (project) 

Creating execution format 

Reviewing Linker, Compiler option, Debug setting 

TK board, COM port setting 

Starting PM plus 

Terminating PM plus 
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3.1 Starting PM plus 
 
 

 

In the Windows Start menu, select [Programs]->[NEC Tools32]->[PM plus] 

 
 
 
 
 

 
 
 
 
 

PM plus start up 
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3.2 Introduction to PM plus 
 
 
 
In PM plus, application programs and environment setting are handled as a single Project, and series of 

actions such as program creation using the editor, source management, build, and debugging are managed. 

Also, one of more project files is managed together as a workspace. 

 

 

 

 
 
 
 
Project window A window in which project names, source files, and include file are displayed using a 

tree structure. 

Output window A window in which the build execution status is displayed. 

 

For details regarding menu bars and tool bars, refer to the PM plus User’s Manual. 

 

Project window Output window 

Tool bar 
Menu bar 
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What is a project? 

A project is the unit in which PM plus executes management, and refers to an application 

system and environment development based on PM plus. 

PM plus complies project information and saves it in a “project file”, from which it is then referenced. 

 

What is a project file? 

A project file is a file to which information such as the source file to be used in the project, the 

device name, the tool options for complying, and the editor and debugger to be used have been 

saved as “project information”. 

The file name format is “ΔΔΔΔprj”. 

Project files are created in folders that are set when creating new workspaces. 

 

What is a project group? 

A project group is a group comprised of a number of projects in an application system. 

The target devices of each project that can be registered to one project group must be the 

same. 

 

What is a workspace? 

A workspace is the unit used to manage all the projects or project group required for one 

application system. 

The file name of multiple project files is saved to a workspace file for referencing. 

The file name format is “ΔΔΔΔprw”. 
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3.3 Loading Workspace (Project) 
 
 

 
Please place the file “TK78K0KF2UZ_RF_TEST” at 

C:¥TK78K0¥SAMPLE_KF2+UZ¥TK78K0KF2UZ_RF_Test 
Please start PM plus from [All Programs] -> [NEC Tools32] -> [PM plus]  
Then, please select “Open Workspace” as shown below. 

 
 

 

 

 
“TK78K0KF2UZ_RF_TEST.prw”and then press the  Open  button. 

Open the folder in which the 

sample program is located. 
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Workspace file name :TK78K0KF2UZ_RF_TEST.prw 

Project group 

Project 

The“TK78K0KF2UZ_RF_TEST.

prw”workspace file is read 
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3.4 Configuration of Linker Option 
 
 
Please open the “Linker Options” window from the pull down menu of  
[Tools] -> [Linker options]. 
Please set the “Load module file”, “On Chip Debug”, and “Security ID”, as shown 
below. 
 

 
 
The Load Module File is required for debugging. 
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The Security ID in all of the sample programs is “FFFFFFFFFFFFFFFFFFFFh”.  
You can change the ID code by writing a new ID code in the ten bytes starting at 
85H. The intension of using the unique ID code is to prevent an unwelcome third 
party from debugging and modifying your source code. To enable the ID code, 
you have to write non-zero value at 84H. In the sample programs, “84H” is set to a 
non-zero value, “2”, by the “option.asm” file. If you set “0” at 84H, the On-chip 
debug operation are disabled. If you forget your unique ID code, or mistakenly 
over-write 0x00(value) at the address of 0x84, the debugger ID78K0-TK is unable 
to access to the CPU via OCD interface. In this case, you have to start over from 
erasing all data in the Flash EEPROM. Then, after your defining a new ID Code, 
you can load the hex file using PG-FPL3 with the new ID code. How to use 
“PG-FPL3” will be explained later.  
 
 
In the “Others” tab, please confirm the path for the directive file as, 
“Include/UZEMI_78k0.dr” 
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3.5 Configuration of Compiler Option 
 
 

 
Please choose [Tools] -> [Compiler Options] at the pull-down menu. 
 
In the opening tab, Macros and path to include files are defined, as shown 
below. 
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You will find two defined macros of “CPU78K0”, and “F053764”.  
The meanings of the macros are as follows, “CPU78K0”: The target CPU is 
78K0.“F054780”: The target MCU is UPD78F0547, and the MCU has 80 pins.  
 
Include Search Path will be,  
Include, 
if you install the project file at this location. If not, please modify it for your 
appropriate path. 
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Please select the Extend tab. 
You will allow the comment in a way supported by C++, using “//”. 
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Then, you will check the Startup Routine.  
 
The “Multiplier/Divider” library is supported at the Startup Routine tab. 
Please note the “Multiplier/Divider” library has been newly introduced  
in the CC78K0 v3.7/W3.7. If you try to use library created by using  
the older versions of the CC78K0 compiler, you will find an error message.  
 
In that case, you have a good chance to solve the problem by clearing  
the check at “Using Multiplier/Divider”. 
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3.6 Configuration of Debugger setting 
 

 
 
 
Please Choose [Tool] -> [Debugger Setting] at the pull-down menu. 
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Please select the “78K0 Integrated Debugger (ID78K0-TK for TK-78K0)”. 
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3.7 TK board setting 
 

 
Please set the switches on the TK-78K0/KF2+UZ board as follows. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

 
 
 

JP1 1-2 short (USB side) 
SW5 OCD side 

Bit1 ON 
Bit2 ON 
Bit3 ON 
Bit4 ON 
Bit5 ON 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 

SW5 

SW1 

JP1 
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Next, the COM port number allocated by connecting the TK-78K0/KF2+UZ board 
with PC is set by "Portconfig for ID78K0-TK". 
 
Now, you need to learn which COM port of your PC is connected to the board. 
To find it, please go to  
[Control Panel] -> [System] –> [Hardware] -> [Device Manager]  
to find something like “USB Serial Port (COM3)”. In this particular case, it is “3”. 
 
Then, please select Portconfig  
at [Programs] -> [NEC Tools32] -> [Portconfig for ID78K0-TK].  
You will find the following window. 
Please set the COM3 in this particular case, but the number of COM port may 
depend on your PC. 
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3.8 Creating execution format 
 
 
 
Please go back to PM plus. 

Please re-compile the project by clicking the  button at the menu bar. 
 

 

 

 
 

Build has been completed successfully.

Build process is  

executed 
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What is build ? 
Build is a function that creates an executable file, etc., from a source file registered to a project. 

PM plus automatically performs compiling, linking, and other processing actions. 

On the second and subsequent build, PM plus also automatically delects files that have been updated  

from the previous build processing, and complies and assembles only the relevant files, thereby reading 

the time required for build processing.  
 
 

What is rebuild ? 
Build compiles and assembles only the source files that have been updated since the previous 

time, whereas rebuild compiles and assembles all the source files.  

When setting, such as compiler options, have been changed, not build, but rebuild, must be  

Selected. 
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3.9 Starting integrated debugger (ID78K0-TK) 
 
 
 
Please select the Debug button  ，of PM plus, or in the menu, select [Build(B)]
→[Debug(D)]. 
 
 

 

 

 

  

 

If "Configuration" screen displayed, click  OK . 
If "Do you want to download Load Module File" message displayed, click Yes . 

 

 

If the debug button is not displayed, in the menu, select [Tool]→[Debugger 
Setting...]“78K0 Integrated Debugger (ID78K0-TK for TK-78K0)” 
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ID78K0-TK starts, and the compiled 

program is downloaded to the flash 

memory with built-in CPU. 

If everytting goes well  
the sourcecode will be displayed. 
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Normally, if communication with the CPU fails, the following error messages are 
output. 
 

 
 
If you observe the message please confirm the following items.  
 
 
 
1. Please confirm the switch on the board is set as follows. 
 

JP1 1-2 short (USB side) 
SW5 OCD side 

Bit1 ON 
Bit2 ON 
Bit3 ON 
Bit4 ON 
Bit5 ON 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 
 
2. Please confirm the COM port number is identical with the one allocated by 

"Portconfig for ID78K0-TK" in TK-78K0?  
 
The COM port number can be confirmed by Start -> Settings -> Control Panel -> 
System -> Hardware -> Device Manager -> Ports.   
 
"Portconfig for ID78K0-TK" can be executed by Start -> Program -> NEC Tools 32 
-> Portconfig for ID78K0-TK. 
 
 
After checking the above items, start ID78K0-TK again. 
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Now, please start ID78K0-TK again. 
If the ID code is wrong, you may find the following messages on the display. 
 

 

 

 

 

The following "Configuration" screen is displayed when OK is pushed and input a correct ID code, please. 

 

 
The ID code in all of the sample programs is “FFFFFFFFFFFFFFFFFFFFh”. 
You can change the ID code by writing a new ID code in the "Linker Options". 
 
The intension of using the unique ID code is to prevent a third party from 
debugging and modifying your source code.  
To enable the ID code, you have to write non-zero value at 84H. In the sample 
programs, “84H” is set to a non-zero value, “2”, by the “option.asm” file. If you set 
“0” to 84H, the ID code is ignored.  
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When the ID code is forgotten, it is necessary to delete all flash memories with 
built-in CPU. 
Please delete the flash memory by installing "PG-FPL3" from CD of the 
attachment. 
Please refer to Chapter 3 for the usage of "PG-FPL3". 

 
 
※ ID Code 
The ID Code is a mechanism to prevent an unwelcome third party from accessing 
your source code by initiating the debugger. Therefore, it is recommended to 
modify the ID Code from the default value to secure your original source code. 
However, once you modify it, then, if you forget the security ID for address of 0x85 
- 0x8E or mistakenly over-write 0x00(value) to the address of 0x84, the debugger 
ID78K0-TK is unable to access to the CPU via OCD interface. In this case, you 
have to start over from erasing all data in the Flash EEPROM. Then, you can 
define the new ID Code. You may load your source code from the debugger with a 
load module file, or you may load the hex file using PG-FPL3 with the new ID 
code. 
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3.10 Introduction of integrated debugger(ID78K0-TK) 
 
 
 
ID78K0-TK displays the internal status of the CPU and controls monitor functions 
in the main window.  
The initial screen of ID78K0-TK is as follows.  
 
< Main window＞ 

 
 
 
 

 
For more details, please refer to the user’s manuals of ID78K0-TK and 
ID78K0-QB. 

 
 

Status bar 

Menu bar 

Window display area 

Tool bar 
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3.11 Executing program 
 
 

If you click “GO” , the execution of the code will start. 
You can know it by the red bar at the bottom. 
However, because this RF Test program requires a key input from Hyperterminal 
to set a test mode, the program is waiting for the key input, while the USB 
connection to PC is occupied with the debugger interface. To debug the each test 
mode of operation, you may modify the source code to specify a test mode by 
skipping the key input. The test modes will be explained later.  
 

 

 

 

Execute the program 
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3.12 Stopping program 
 
 
 
Stop the program. 
Press the ID78K0-TK’s stop button  , or in the menu, select [Run]→[Stop]. 

 

 

 
 
When the program stops, the status bar changes back to its original color.  

 
 
 

Stop the program 
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3.13 Terminating integrated debugger (ID78K0-TK) 
 
 

In the ID78K0-TK menu, select [File]→[Exit].  

 

 
 
 
 

 
 

 
 
 
If you push the “Yes”, ID78K0-TK is terminated after preserving a present 
environment.  
If you push the “No”, ID78K0-TK is terminated without preserving a present 
environment. 

 

The Exit confirmation dialog box is 
displayed. 
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3.14 RF Test Program 
 
 
 

3.14.1 Procedure for one to one transmit/receive test 
 

1). Assumption here in this section is, you have two TK-78K0/KF2+UZ boards, 
in one of which the execution code for the TK78K0KF2UZ_RF_TEST was 
programmed by the debugger. You also prepare two PCs, one PC with USB 
interface and hyper-terminal to control the transmitter side of the 
board, and the other one with USB interface to the second PC for  
debugging at the receiver board. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
2). Now, you designate the one TK-78K0/KF2+UZ board loaded with the  
execution code in the previous procedure as a transmitter. Another board, which 
is not loaded with the execution code is now designated as a receiver, which send 
back the test result to the sender. The receiver board can work without PC, but 
now, you set this board to the debug mode. Please set the switches on the 
receiver board as follows. 
 

Receiver Debugger use. 

Execute ID78K0-TK.

Transmitter use as Stand alone. 

Execute terminal software. 

Short address : 0001 Short address : 0002 
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JP1 1-2 short (USB side) 
SW5 OCD side 

Bit1 ON 
Bit2 ON 
Bit3 ON 
Bit4 ON 
Bit5 ON 
Bit6 ON for address setting 
Bit7 OFF 

SW1 

Bit8 ON for the receiver mode 
 
 
The above example is for the short address of 0002. 
There are four ways of the address setting as follows, 
 

Short Address 
 

0001 0002 0003 0004 
Bit6 OFF ON OFF ON 

SW1 
Bit7 OFF OFF ON ON 

 
Please connect the receiver board to your first PC with a USB cable. 
Now, please repeat the procedures described in the section “2.9 Starting 
integrated debugger”. 
You will see the C-source window, as shown below. 
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Now, please click “GO” to run the program. 
 
 

 

 
 

You will see the red bar at the bottom. 
 
Now the receiver board is ready. 
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 Please set the transmitter board as follows, 
 

JP1 1-2 short (USB side) 
SW5 UART side 

Bit1 OFF 
Bit2 OFF 
Bit3 OFF 
Bit4 OFF 
Bit5 OFF 
Bit6 OFF for address setting 
Bit7 OFF 

SW1 

Bit8 OFF for the transmitter mode 
 
 
This example is for the short address of 0001. 
This board is designated as the transmitter. 
 
Then, please connect it to your second PC with a USB cable. 
 
Then, please identify the COM port number of the USB in your PC  
at [Control Panel]  [System]  
 
 
 
4). Hyper Terminal 
 
On MS-Windows in your PC, please select [All Programs] -> [Accessory] -> 
[Communication] -> [HyperTerminal] 
 
Setting of Hyperterminal 
  

 
 
 
 
 

 
 (Property -> Setting -> ASCII) 
 Local Echo OFF 
 No Line Feed 
 
 

Bits per second 19200 

Data bits 8 

Parity None 

Stop bits 1 

Flow control None 
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Now you will find the following opening menu in the window. 
If not, please try the RESET button on the board. 
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7). Execution of the Transmit/Receive Test 
 
To initiate the PER, Packet Error Rate, test, please press 1 in the menu. You will 
see [My Profile], 
then, be asked for the destination of the PER test, as shown below. 
 

 

 
 
Now, you may input “0002”. 
Then, you will be asked how many packets you wish to consume in the PER test. 
You may input “1000”. 
Then, you will be asked the interval of packets in msec. 
You may input 3 msec. 
Then, the PER test will be executed.  
You will see, 
the number of packets sent, that is, 1000 as you input, 
the number of the received packets, 
the calculated PER in % 
and the maximum and minimum RSSI values in the PER test. 
 
[Note]  
PER= Packet Error Rate 
RSSI= Received Signal Strength Indication 
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RSSI is expressed in the hexagonal value of 256 levels, which indicates the signal 
strength in the received signal. For more details of the RSSI value, please refer to 
the datasheet of the UZ2400 RF chip. 
 
Please note the PER and the RSSI are measured at the receiver side. 
The receiver does not send back the test packets, but only the test result. 
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8). Channel setting 
 
In the previous example, you may have also found the RF channel used in this 
test is the Channel 11. The channel is specified by the IEEE 802.15.4 
specification. 
The channel 11 is assigned at 2405 MHz. You can change the channel in the PER 
test in 5MHz step to the maximum channel of 26th at 2480 MHz. 
To do it, please press “9” in the command prompt. Then, please choose the 
channel by [+], [-], [A], [B], or [C]. In the example below, the channel 23th, 2465 
MHz, was selected.  
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To execute the PER test at the channel 23, press [Enter] in your keyboard, then, 
choose “1” to initiate the PER test mode. Then, you may input 1000 packet in 5 
msec interval to see the following example. Please confirm the channel used is 
23th in the display. Please note the receiver will learn which channel is to be used 
for the test automatically. 
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9). Adjusting the output power 
 
You may wish to control the output power in the PER test.  
For it, please select “0” in the menu. 
You will be asked the register ID. Please input “203”. 
Then you will see, “LREG[203] : 00 >”. 
It means the current value at the register [203] is 0x00h, which means 0 dB. 
0x00h is the reset default. 
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The register bits are defined as follows, 
 
LREG[203]:  

[7:6] -> large scale tuning 
 00: 0 dB  
01: -10 dB 
10: -20 dB 
11: -30 dB 
[5:3] -> small scale tuning 
000: 0 dB 
001: -1.25 dB 
010: -2.5 dB 
011: -3.75 dB 
100: -5 dB 
101: -6.25 dB 
110: -7.5 db 
111: -8.75 dB 
[2:0] -> 000 

 
For instance, if you wish -15 dB, please input “60”, as follows, 
 
“LREG[203] : 00 > 60”  
 
Then, you will start the PER test. 
 

 
 
 



- 76 - 

The minimum output power is set by “F8”. 
 

 
 
You may find larger PER value with smaller RSSI value in this case. 
 

 
 
Please note this adjustment is applied only to the transmitter. The receiver 

always sends back the test results with the 0 dB output power using the channel 
11th. 
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3.14.2 PER test / receiver 
 
The Menu 2 sets the board to the receiver in the PER test. 
If you have two PCs, you can connect two boards to each of two PCs, then, 
you will apply this mode to one of them.  
In your current case, your receiver board is now being connected to the 
debugger. Therefore, you cannot access to these menu to utilize this mode 
setting. Alternatively, you have set the receiver board to the receiver mode 
by setting the switch 1-8. 
 

3.14.3 Continuous TX / Pseudo Noise 
 

The Menu 3 initiates the modulated RF transmission. The data carried are 
pseudo random numbers. You can define the channel using the menu 9, 
and the output power using the menu 0. 

 
 

3.14.4  Continuous TX / Raw carrier 
 

The Menu 4 initiates the carrier transmission. The output power is not 0 dB 
as a reset default. You can define the channel using the menu 9. 

 

3.14.5 RX Mode 
 

The Menu 5 initiates the receiver mode. 
 

3.14.6 IDLE MODE 
 

The Menu 6 sets the UZ2400 into the IDLE mode. 
 

3.14.7 Sleep MODE 
 

The Menu 7 sets the UZ2400 into the Deep Sleep mode. 
 

 

3.14.8 Standby MODE 
 

The Menu 8 sets the UZ2400 into the Standby mode. 
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3.14.9 Set RF channel 
 

The Menu 9 allows you to set the RF channel. 
 
 

3.14.10 Manually set UZ2400 register 
 
The Menu 0 allows you to set the UZ2400 registers. 
Please refer to the datasheet of the UZ2400 RF chip for the definition of 
registers. 

 
 

3.14.11 Resetting RF 
 

The Menu A allows you to reset the UZ2400 registers. 
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3.15 Creating new hex files 
 
 
 
 
 
After debugging, you may wish to copy the new object code to other TK boards. 
In this case, you may not want to start-up the debugger for every board,  
but, may wish to make copies using the PG-FPL3 Flash programmer. 
For it, please create a new hex file, following the procedure described in this 
session.  
 

 
 

In the release build mode of the PM plus, please open  
the “Object Converter Options” window from the pull-down menu of [Tool]. 
Please click “Create HEX Module” tab and define the path and the file name  
of the new hex file. In this example, it is 
“Release/TK78K0KF2UZ_RF_TEST”. 
After re-compile, you will find the “TK78K0KF2UZ_RF_TEST.hex” in the 
directory. 
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You will learn how to program other TK boards with the hex file in the next 
chapter. 
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3.16 Creating a new PM plus workspace (project) 
 
 
 
You may wish to create a new work space in the PM plus to initiate a new project. 
Please select select [File]→[New Workspace...] in the pull-down menu of the PM 
plus.  

  

 

 

  

            

 

The dialog box for creating 

New workspace is displayed

<Description of items> 

Workspace File Name: 
 -> Specify the name of the workspace file that 

manages the project files. 
.prw is automatically suffixed as the file 
type. 
A project file (.prj) of the same name is 
simultaneously created. 

Folder: 
 -> Specify the folder for saving the workspace 

file by writing its absolute path. 
    This item can be selected from a reference 

dialog box by pressing the Browse…
button. 

Project Group Name: 
 -> Specify this item if wishing to manage 
multiple projects together in function units.
If nothing is specified, this item is the 
same as the workspace file name. 

Series Name: 
 -> Specify the series name of the device to be 

used. 

Device Name: 
 -> Specify the name of the device to be used.
 

The concrete information set here is 
described on the following pages 
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                                        Push the Next > button. 

 
 

 
 Push the Yes button. 

 
 

                            Push the Next > button. 

Input the workspace information 
setting as follows. 

Workspace file name 
 → test 

Folder 
   C:¥TK78K0¥test 

Project Group Name 
 → Don’t input this item. 

Series Name 
 → 78K/0 Series 

Device Name 
 → uPD78F0547_80 
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Please select 78K0 Integrated 
Debugger (ID78K0-TK for TK-78K0) 

 

 

 
Push the Next > button. 

 

  
Push the Finish button. 

 

 

 

Check the project information 

setting contents. 
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This completes workspace and project creation. 

Additional source files can be registered at any time thereafter. 

For details, refer to ”Registering additional source file”  

 

Next, on chip debug function can be used. 

[Tool] → [Linker Options...] is selected. 

 

 

 

Project “test" was registered. 
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Checks are put in "On-Chip Debug" and 

"SIZE". Then input a default value of 

“256” into the “SIZE”. 

A check is put in "Security ID".  

The actualities of 

 "FFFFFFFFFFFFFFFFFFFF" are taken 

if there is no problem in the value of ID in 

security. 

 

 
Push the OK button.  

 
 
Please copy the “option.asm” file to the new work space from the “RF Test 
Program”.  
Please refer to the “1.1Configuration of Linker Option” for further details of 
security ID. 
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3.17 Registering additional source file 

 
 

The method for registering additional source files to a project is described below. 

The following example shows the additional registration of source files “b.c” and “c.c” with source file “a.c” 

already registered. 

Place the cursor on the source file in the Project window of PM plus, and select [Add Source Files…] 

displayed in the right-click menu  

 

 

 

 

Select source files “b.c” and “c.c” and 
then press the Open button. 

 

 Multiple source files can be selected by clicking the desired source files where pressing Ctrl key. 
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Source file “b.c” and “c.c” 
are additionally registered 
to the project. 
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3.18 Terminating PM plus 
 
 
 
 

In the PM plus menu, select [File]→[Save Workspace].  
Then, select [File]→[Close Workspace].  
 
In the PM plus menu, select [File]→[Exit PM plus].  

 

 

 

 
PM plus ends. 
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4 How to use PG-FPL3 
 
 

PG-FPL3 is a software Flash EEPROM programmer, working on MS Windows. 
PG-FPL3 enables you to program your application program file of hex format in 
the Flash EEPROM, embedded on the 78K0/KF2 microcontroller on the 
TK-78K0/KF2+UZ board, via the USB interface of the board. You do not need any 
hardware, additionally to your PC and the TK-78K0/KF2+UZ board, to make the 
programming. 

 
 
 

4.1 Installation of PG-FPL3 
 

Please set the CD-ROM in your PC. 
Please find “Setup.exe” at /FPL3/FPL3_V110, then, execute it. 
 

4.2 How to use PG-FPL3 
 
Please keep the CD-ROM in your PC. 
Please set switches on the TK-78K0/KF2+UZ board as shown below. 
 
 

JP1 1-2 short (USB side) 
SW5 UART side 

Bit1 ON 
Bit2 ON 
Bit3 OFF 
Bit4 OFF 
Bit5 OFF 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 
 
Now you connect the TK-78K0/KF2+UZ to your PC. And confirm the green LED 
lighting.   
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Please select PG-FPL3 at [Programs] -> [NEC Tools32] -> [PG-FPL3].  
You will see the main window, as shown below. Please click “Setup”. 
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You will see the setup window, shown below. 
Please click “PRM File Read”. 

 
 

 

Please select “78F0547D.prm” in the directory of “PRM78F0547_V105” in the 
CD-ROM. 

 
 

 

 

 
 
 
 
 



- 92 - 

Then, “Port” is to be selected. You will choose the number of the COM port, where 
the 78K0 UZ Stick is inserted.  
 
If you do not know the COM port number, please go to Control Panel Start -> 
Control panel -> System -> Hardware –> Device Manager to find something like 
“USB Serial Port (COM3)”. In this particular case, it is “3”. The number may be 
another one, depending on a PC or a USB terminal. Please select your COM port 
number in the pull-down menu. The pull-down menu displays all of available COM 
ports in your PC. 
 
Please set “16.00” in the “Frequency”, then, click OK. 
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The next action is the loading of the hex file to the PG-FPL3. 
In this example, “TK78K0KF2UZ_RF_TEST.hex” found at 
“TK78K0KF2UZ_RF_Test/Release” is loaded. If everything goes well, you will 
see a message of “Success read HEX file”, as shown below. 
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Then, if you click “Auto procedure”, erasing, programming, and verification are 
executed. Alternatively, you can execute erasing, programming, and verification, 
one by one by clicking the three buttons located at the left of the “Auto procedure” 
button. 
 
If you see “Flash internal Verify OK!”, your program has been successfully loaded 
in the Flash EEPROM. Then, you can disconnect the TK-78K0/KF2+UZ from your 
PC. 
 
Now, you will program the hex file in the second, or possibly third, and more. 
 

Or, if you like to initiate the program immediately, while keeping the USB 
connection, please set the Switch 1-1, and 1-2 to OFF, then the program will start 
with Hyper-terminal. Please go to the next chapter for this procedure. 
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5 IEEE 802.15.4 MAC Sample Program 
 

 
 
Two sample implementations utilizing the MAC stack are offered in this evaluation 
kit.  
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5.1 The MAC Sample program 1 :TextChat 
 
 
This chapter introduces the usage of MAC application 1 
 

The MAC Sample program 1 is developed to provide with a simple example 
to construct a star network utilizing the IEEE 802.15.4 PHY/MAC standard. 
 
The MAC Sample Program offers, 

1. Designation of a network coordinator in a star configuration 
2. Text chat between a coordinator and an end device 

 
To use the MAC Sample Program 1, you need to prepare at least two PC with 
a USB interface and two TK-78K0/KF2+UZ boards.  
 
The MAC Sample Program 1 is provided in the form of the hex file, as well as 
the C source codes.  
 
The hex files, TK78K0KF2UZ_Sample1_01.hex, _02.hex, _03.hex, _04.hex 
and _05.hex allow you to immediately program to your TK-78K0KF2+UZ 
boards using the PG-FPL3 Flash EEPROM programmer, and start the 
sample application. The TK78K0KF2UZ_Sample1_0x.hex files are available 
at  
C:/TK78K0/SAMPLE_KF2+UZ/TK78K0KF2UZ_Sample1/Release. 
 
Or, if you wish to tailor the sample program to meet your specific needs, you 
can edit the source code, re-compile it with debug build to generate a load 
module file, then, start the debugger to load the tailored execution code on to 
the microcontroller for further debugging on the project manager PM plus. In 
this procedure, the Flash programmer PG-FPL3 is not required. However, 
because the USB connection to instruct operation to the program is occupied 
for the debugging purpose, alternatively, you can make a release build to 
achieve a new hex file, on the project manager PM plus. 
 

As a general remark, please respect your local regulation of electro-magnetic 
emission. In general, it is suggested to use the TK-78K0/KF2+UZ board in a 
radio anechoic chamber. 
 
It supports text chat for one coordinator and 4 end devices. 
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5.1.1 Programming to the TK boards 
 
For chatting, please prepare minimum 2, or maximum 5 TK-78K0/KF2+UZ 
boards. 
You need identical numbers of PCs. 
 
 
Some laptop PCs do not support full functionality of hyperterminal. 
This software has been confirmed at 
NEC MATE MY25XCZEG  
and, NEC VERSAPRO VY10F/BH-M 
 
Please program the hex files of TK78K0KF2UZ_Sample1_01.hex, _02.hex, 
_03.hex, _04.hex and _05.hex to each of your TK-78K0/KF2+UZ boards 
using PG-FPL3. 
 
 

5.1.2 Setting up the  board to your PC 
 

1). Assumption here in this section is, you have two or more 
TK-78K0/KF2+UZ boards, in which the 
TK78K0KF2UZ_Sample1_0x.hex were programmed. 

 
2). Please set the following switch configuration on all of your boards. 
 

JP1 1-2 short  
(USB side) 

SW5 UART side 
Bit1 OFF 
Bit2 OFF 
Bit3 OFF 
Bit4 OFF 
Bit5 OFF 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 
 
3). Then, please connect it to your PC with a USB cable. 
 

Please set the Jumper 1 to USB to supply voltage to the board from USB 
I/F of the PC. 
Then, please identify the COM port number of the USB in your PC at 
[Control Panel]  [System]  
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4). Hyper Terminal 
 

On MS-Windows in your PC, please select [All Programs] -> [Accessory] -> 
[Communication] -> [HyperTerminal] 
 
Setting of Hyperterminal 
  
 
 
 
 
 
  
(Property -> Setting -> ASCII) 
 Local Echo OFF 
 No Line Feed 
 

 
Now you will find the following opening menu in the window. 
If not, please try the RESET button on the board. 
 

 
 
Then, press Enter, 
 

 
 
Please do the same for your other boards and PCs. 

Bits per second 19200 

Data bits 8 

Parity None 

Stop bits 1 

Flow control None 

----------------------------------------- 

  TK-78K0/UZ Sample Application 

----------------------------------------- 

  2006 Skyley Networks 

 

 

  Command > 

[Help] ------------------------- 

S: Send Message 

M: MLME Associate test 

C: Start Coordinator test 

-------------------------------- 

 

Command? > 



- 99 - 

5.1.3 Designation of a coordinator 
 

Now, you must decide which board is a coordinator. 
Go to the PC of the coordinator board, and press C. 
 

 
 
Now the coordinator has started. 

 

5.1.4 Network Association 
 

For other PCs for other boards, please press M. 
 

 
 
Now, this particular board was associated to the network as an end device 
with the short address of 4321. Please repeat this step for your third, fourth, 
and possibly fifth board. 
 

Command? >M 

 

> MLME-ASSOCIATE.request 

> MLME-ASSOCIATE.confirm 

>  Associated ShortAddr:4321 

>                Status:00 

 

Command? > 

Command? >C 

 

> MLME-START.request 

> MLME-START.confirm 

>  Status:00 

 

Command? > 
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On the coordinator side, you will find the following message, if the 
association is successful. 
 

 
 

 

5.1.5 Text Chat 
 

Now the network is prepared for you to start text chat between an end 
device and the coordinator. 
 
At first, you may start with the coordinator. 
 
Press S, then input the short address of an end device, 4321 in this 
example, 
then, input your text message, up to 102 bytes.  
 

 
 
 

 

Command? >S 

 

> MCPS-DATA.request 

> Send to (short address) ? 4321 

> Message ? Hello! 

 

Command? > 

> MLME-ASSOCIATE.indication 

>  from 123456789ABC0001 associated to 4321 

 

[Help] ------------------------- 

S: Send Message 

-------------------------------- 

 

Command? > 
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You will find the following message on the end device, 4321. 
The sender’s short address is “1975”, and the PAN ID is 2420 in this 
example. 
 

 
 
Now, you can reply from the end device “4321” to the coordinator “1975” by 
inputting S, 1975, and your reply text. 
 
 

 
 
 

Command? > 

> MCPS-DATA.indication 

>  from 1975/2420 

Hello! 
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5.2 The MAC Sample Program2 : LED Control 
 
 
 
The MAC Sample program 2 is developed to provide with another simple example 
to construct a star network utilizing the IEEE 802.15.4 PHY/MAC standard. 
 
The MAC Sample Program 2 offers, 
1). Designation of a network coordinator in a star configuration 
2). If you push a switch on the n th end device, an LED on the coordinator board 
blinks on and off n times. 
 
To use the MAC Sample Program 2, you need to prepare one PC with a USB 
interface and two TK-78K0/KF2+UZ boards or more boards, up to 5.  
The MAC Sample Program 2 is provided in the form of the hex file, as well as the 
C source codes with the MAC library.  
 
The hex file, TK78K0KF2UZ_Sample2.hex, allows you to immediately program to 
your TK-78K0KF2+UZ boards using the PG-FPL3 Flash EEPROM programmer, 
and start the sample application. The TK78K0KF2UZ_Sample2.hex file is 
available at 
C:/TK78K0/SAMPLE_KF2+UZ/TK78K0KF2UZ_Sample2/Release. 
 
Or, if you wish to tailor the sample program to meet your specific experiment, you 
can edit the source code, re-compile it with debug build to generate a load module 
file, then, start the debugger to load the tailored execution code on to the 
microcontroller for further debugging on the project manager PM plus. In this 
procedure, the Flash programmer PG-FPL3 is not required. However, because 
the USB connection is occupied for the debugging interface, the USB connection 
is not available for applications. In this application example, Hyperterminal with 
USB connection offers information on the network association. However, the LED 
operation can be made without Hyperterminal. Therefore, you can use the USB 
connection for debugging for the LED operation. Alternatively, you may make a 
release build to achieve a new hex file, on the project manager PM plus.  
 

As a general remark, please respect your local regulation of electro-magnetic 
emission. In general, it is suggested to use the TK-78K0/KF2+UZ board in a radio 
anechoic chamber. 
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5.2.1 Programming to the TK boards 
 
Please prepare minimum 2, or maximum 5 TK-78K0/KF2+UZ boards. 
You need at least one PC to load the hex file on to the boards. However, for 
LED operation, you don’t need any PC. 
 
You will designate one board as a coordinator, and the rests as end devices.  
However, the hex file is common for both a coordinator and end devices, 
because the role setting is made by a switch on board. 
 
Please program the hex files of TK78K0KF2UZ_Sample2.hex to all of your 
TK-78K0/KF2+UZ boards using PG-FPL3. You will find  
the TK78K0KF2UZ_Sample2.hex file 
at the directory of “TK78K0KF2UZ_Sample2¥Release”. 

 

5.2.2 Starting up a coordinator 
 
 
1). Please set the following switch configuration on all of your boards. 
 

JP1 1-2 short (USB side) 
SW5 UART side 

Bit1 OFF 
Bit2 OFF 
Bit3 OFF 
Bit4 OFF 
Bit5 OFF 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 
 
2). Now, you choose one board as a coordinator. 
 
3). Then, you have a choice if you use the coordinator with or without 

HyperTerminal. 
 
4). If you like to use HyperTerminal, please set the Switch 5 to battery, then, 

connect the coordinator board to the PC with a USB cable.   
 

Then, please connect it to your PC with a USB cable. 
Please set the Jumper 1 to USB to supply voltage to the board from USB 
I/F of the PC. 
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Then, please identify the COM port number of the USB in your PC  
at [Control Panel]  [System]  

 
5). HyperTerminal 
 

On MS-Windows in your PC, please select [All Programs] -> [Accessory] -> 
[Communication] -> [HyperTerminal] 
 
Please set the parameters of HyperTerminal as follows, 
 

 
 
 
 
 

 
(Property -> Setting -> ASCII) 
 Local Echo OFF 
 No Line Feed 
 

6). After you open the window of the HyperTerminal, please push the reset 
button on the board. Now you will find the following opening message in 
the window. 
If not, please reconfirm the COM port number of the USB connection. 

 

 
Now the coordinator has started up successfully. 

Bits per second 19200 

Data bits 8 

Parity None 

Stop bits 1 

Flow control None 
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5.2.3 Starting up end devices 
 
1). Please set the following switch configuration on all of your boards. 
 

JP1 2-3 short (USB 
side) 

SW5 UART side 
Bit1 OFF 
Bit2 OFF 
Bit3 OFF 
Bit4 OFF 
Bit5 OFF 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 
 
2). Now, you connect batteries to all of your boards for end devices.. 
 
3). Then, if you set Jumper 1 to battery, the board starts up as another 

coordinator. You need to keep pushing the Joy stick, Switch 2, to start up 
as an end device. You can assign 5 different MAC addresses by a position 
of the Joy Stick during power-up sequence, or RESET start-up. 

 
 

Position of Joy Stick during 
start-up 

Function Extended Address 

Default Coordinator 0x1234xxxx9ABC0001 
Up End Device 0x1234xxxx9ABC0002 
Center End Device 0x1234xxxx9ABC0003 
Left End Device 0x1234xxxx9ABC0004 
Right End Device 0x1234xxxx9ABC0005 
Down End Device 0x1234xxxx9ABC0006 
 
If you start-up a board while keeping the Joy Stick up, you will see the 
following message on the HyperTerminal. 
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A short address of “4352” was assigned to the board. 
A short address is assigned sequentially, independent from the long 
address. 
Then, if you start-up the third board while keeping the Joy Stick center, you 
will see the following message on the HyperTerminal. 
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5.2.4 Operation 
 
The coordinator generates beacon at channel 11 of 2405 MHz. 
LED4 on the board is ON. 
 
An end device makes a network association. If successful, LED4 on the 
board is ON. 
 
If you push SW3 on an end device, LED2 on the coordinator blinks. 
And, if you push SW4 on an end device, LED3 on the coordinator blinks. 
 
The number of times of blink depends on the sequence the end device joined 
in the network. For instance, if an end device is the third end device for the 
network, the LED will blink three times. 
 
 
 

LED on Coordinator SW on End Device 
LED2 SW3 
LED3 SW4 

 
The following example shows, the SW3 on the fifth end device, “4356”, was 
pushed. You will see the LED2 on the coordinator will blink 5 times.  
The default PAN ID of this network is “2420”.  
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6 Mode setting of the board 
 

 
 
 
The combination table of the switch of this board is shown. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Usage case 
SW 

Normal  (Written 
program works) 

Debug  (USB 
Connection) Writing flash 

SW5 UART side OCD side UART side 

JP1 
Select by power 
supply source 

1-2short (USB side) 1-2short(USB side) 

Bit1 OFF ON ON 
Bit2 OFF ON ON 

Bit3 OFF ON OFF 

Bit4 OFF ON OFF 

SW1 

Bit5 OFF ON OFF 
 

SW1 

JP1 

SW5 
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